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The medium voltage digital motor control (DMC) evaluation module (DRV8313EVM, Figure 1), provides a
cost-effective sensor-less solution to run a 3-phase BLDC motor in trapezoidal commutation. This
document gives the complete detail of the EVM including its hardware details, jumper configuration,
operating procedure to run the BLDC motor using GUI and in standalone.
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1 INTRODUCTION

The available GUI only supports sensorless commutation. However, a hall sensor connection option is
provided in hardware for use with sensor-based algorithms.

Figure 1. DRV8313EVM Top View
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WARNING

This EVM is meant to be operated in a lab environment only and is
not considered by TI to be a finished end-product fit for general
consumer use. This EVM must be used only by qualified engineers
and technicians familiar with risks associated with handling high
voltage electrical and mechanical components, systems and
subsystems. This equipment operates at voltages and currents
that can result in electrical shock, fire hazard and/or personal
injury if not properly handled or applied. Equipment must be used
with necessary caution and appropriate safeguards employed to
avoid personal injury or property damage. It is the user’s
responsibility to confirm that the voltages and isolation
requirements are identified and understood, prior to energizing the
board and or simulation. When energized, the EVM or components
connected to the EVM should not be touched.

1.1 Hardware Block Diagram

Figure 2 illustrates a typical motor drive system running from a dc power supply input (8 V to 60 V). The
DRV8313EVM motor control board has all the power and control blocks that constitute a typical motor
drive system for 3-phase BLDC motors. The EVM provides an easy to use GUI interface to enable motor
operation from an external PC or laptop.

Figure 2. DRV8313EVM Hardware Block Diagram
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1.2 DRV8313 EVM Hardware Macro Blocks

The motor control board is separated into functional groups that enable a complete motor drive system;
these are referred to as macroblocks. Following is a list of the macroblocks present on the board and their
functions:

• DC bus connection at terminal block J2

• 3-phase motor connection at terminal block J3

• DRV8313 – This module includes the DRV8313 three phase PWM motor driver as well as all of the
necessary external passive components.

• On board MSP430G2553 value line micro-controller with 8 k flash

• USB interface- Micro-USB interface connector is used for serial UART communication with FTDI driver
chip to run the EVM using GUI through external PC/Laptop

• Current sense – Low-side shunt current sensing on dc-link current measurement

• On board 5 VCC control power supply for hall-effect sensors and 3.3-V supply for MCU

• On board potentiometer for speed control to run BLDC motor in stand-alone mode without using GUI

• 4-pin JTAG interface connector for SPI-BY-WIRE Programming

• 16-pin connector – This provides interface to all control signals of DRV8313 and it can be used to drive
DRV8313 from an external micro-controller

• Hall effect sensor connections – Connections are available for optional Hall effect at J7. The included
GUI only supports sensor-less commutation. Hall connections are provided for use when developing a
sensored motor control project.

• Manual reset switch to reset the controller

Figure 3 illustrates the position of these macroblocks on the board. The use of a macroblock approach for
different power stages enables easy debugging and testing of one stage at a time. All the PWM and ADC
signals which are the actuation and sensing signals have designated test points on the board, which
makes it easy for an application developer to try out new algorithms and strategies.

http://www.ti.com
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Figure 3. DRV8313EVM Macro Blocks and Jumper Setting

1.3 Jumper Configuration

Two jumpers are used on the DRV8313 EVM:

1. Three-Pin Jumper JP1: This jumper gives the user an option to select a 3.3-V source for on-board
MCU U5 (MSP430G2553). There are two sources of 3.3 V; one is a 3.3-V reference output of
DRV8313 and other is generated from input voltage VM through on-board LDOs U6 (LM2936) and U7
(TLV70433).

a. Position 1-2: In this position, MCU U5 is powered from DRV8313. This position is used for input
DC voltage range of 8 V to 48 V.

b. Position 2-3: In this position, MCU U5 is powered from on board LDOs. This mode is used to avoid
over-heating of DRV8313 if input DC voltage VM is higher than 48 V.

2. Two-Pin Jumper JP2: This jumper must remain closed during all normal operating conditions of EVM
either through GUI or in stand-alone mode. The jumper is open only during the programming of
MSP430G2553 through 4-pin SPI-BY-WIRE method.

1.4 Power-Up Sequence

1. Make sure the jumpers are configured as explained in previous section.

2. Connect 3-phase BLDC motor terminal at terminal block J3. It is not important to observe polarity, as it
only applies to direction of rotation. Make sure all three pins are connected.

3. Apply VM (+24 V) at terminal block J2. EVM does not have reverse polarity protection, therefore make
sure positive terminal of power source is connected to VM and negative terminal is connected to GND.

4. Connect USB connector to the J6 USB connector from external PC/Laptop.

5. Open DRV8313 EVM GUI from location Start → All Programs → Texas Instruments Inc. →

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLVU815A


GUI Software Installation www.ti.com

6 SLVU815A–November 2012–Revised October 2018
Submit Documentation Feedback

Copyright © 2012–2018, Texas Instruments Incorporated

DRV8313EVM User’s Guide

DRV8313EVM to enable motor operation.

2 GUI Software Installation

The following section explains the location of files and the procedure for installing the software correctly.

NOTE: Ensure that no USB connections are made to the EVM until the installation is completed.

The installer will also install LabVIEW RTE 2014 and FTDI Driver, along with the GUI.

2.1 System Requirements

• Supported OS – Windows 7 (32 Bit,64 Bit). The window text size should be Smaller-100% (Default)

• Recommended RAM - 4GB or higher

• Recommended CPU Operating Speed – 3.3 GHz or higher

2.2 Installation Procedure

The following procedure helps you install the DRV8313 GUI

1. Double click on the Setup_DRV8313_EVM.exe as shown below.

Figure 4. Setup_DRV8313_EVM.exe

http://www.ti.com
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2. The screen shown below appears, indicating installer initialization. Click the Next button.

Figure 5. Installation Initialization

3. In the newly open installation pop-up window, click Next. The license agreement will be displayed.
Please, read through it carefully and enable the "I Accept the Agreement" radio button and press Next.

Figure 6. License Agreement

http://www.ti.com
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4. A screen as shown below appears, displaying the license agreement of National Instruments. Please
read through the agreement carefully and enable the “I Accept the License Agreement” radio button
and press the Next button.

Figure 7. NI License Agreement

5. Set the default directory for the GUI Installation and click Next.

http://www.ti.com
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Figure 8. Installation Directory Screen

NOTE: It is highly recommended to keep the default values as provided in the installer.

6. A screen as shown appears. This screen is to select the components to install. Select the Components
to Install and Click Next to continue installation. The LabVIEW RTE component checks out if the
LabVIEW RTE 2014 is already installedon the PC.

http://www.ti.com
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Figure 9. Component Selection

7. If LabVIEW RTE is selected as a component to install, a screen appears as shown below. Configure
the proxy settings as required. This screen is to download the LabVIEW RTE 2014 from ni.com, Click
Next to continue the installation.

Figure 10. Configure Proxy

http://www.ti.com
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8. A screen as shown appears. Click Next to begin the installation.

Figure 11. Ready to Install

9. If the LabVIEW RTE 2014 is selected as a component to install, LabVIEW RTE downloads and
performs a silent mode installation.

Figure 12. Downloading RTE

http://www.ti.com
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10. Once the Download completes, LabVIEW begins with the self-extraction as shown below.

Figure 13. LabVIEW RTE Self Extraction

11. A Screen appears as shown below. It initializes the LabVIEW RTE Installation.

http://www.ti.com
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Figure 14. LabVIEW RTE Installation Initialization

12. A display as shown below appears which indicates the progress of LabVIEW RTE installation.

http://www.ti.com
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Figure 15. Installation of LabVIEW RTE in Progress

13. Once the LabVIEW RTE 2014 is installed, DRV 8313 EVM GUI component installs.

14. After DRV8313 Installation, FTDI Installation begins. A screen as shown in the figure appears, click
Extract to proceed.

http://www.ti.com
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Figure 16. FTDI Installation Initialization

15. A screen as shown in the figure appears, click Next to proceed.

Figure 17. Driver Installation Wizard

http://www.ti.com
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16. The License Agreement appears on screen as shown below.

17. Read through the License Agreement carefully and enable the “I Accept this Agreement” radio button
and Click on Next.

Figure 18. License Agreement for FTDI Driver

18. Click Finish to complete the Driver Installation.

http://www.ti.com
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Figure 19. Driver Installation Completion

19. The following screen appears denoting the completion of DRV8313 EVM GUI Installation. Click
Finish.

Figure 20. Installation Complete

http://www.ti.com
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20. A Readme window as shown below appears displaying the link for LV 2014 RTE.

Figure 21. Readme Window

WARNING

The DRV8313 EVM GUI requires the LabVIEW Run-Time Engine
2014 to be installed before the GUI executes. Please note the
application is not compatible with other versions of LabVIEW
Runtime Engine.

You can download National Instruments LabVIEW Run-Time Engine 2014
from the below link:

LabVIEW Run-Time Engine 2014

NOTE: DRV8313 EVM GGUI executable has been built in LabVIEW 2014 (32-bit) version, and it

expects the LabVIEW Run-Time Engine version to be LabVIEW Run-Time Engine (32-bit

version).

3 DRV8313 EVM GUI Overview

The DRV8313 EVM GUI is the software counterpart for the DRV8313 EVM. It is in charge of connecting to
the MSP430 microcontroller via a USB connection which in turn selects the proper logic state for the
DRV8313 control signals. The graphical user interface (GUI) has been designed to allow for all of the
DRV8313 device’s functionality to be tested without having to intervene with the hardware, except for the
proper configuration of jumpers when needed Figure 3.1 shows the DRV8313EVM High-Level Page.

http://www.ti.com
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Figure 22. DRV8313 EVM Screen

3.1 Pages in the GUI

The GUI has one page.

• High Level Page - it contains menu items to configure andenable/disable the serial port, frames with
GPIO control for the DRV8313 control signals, stepper motorcontrol for start/stop and speed, and
current/decay control through the MSP430 DACs.

3.2 DRV8313 EVM Controls

Once the connection is established as mentioned in the first section, the motor parameters can be tuned
with the ‘Main’ and ‘Settings’ controls. Description of each component is given below:

1. Enable Motor: Once the parameters are set, clicking the checkbox should start the motor. Clicking the
checkbox again stops the motor.

2. Control Mode: The motor speed can be controlled in 3 control modes:

a. Duty Cycle: Motor runs in open loop mode in this control mode. The control knob can enter the
value from 10 to 97 in either direction which represents the % duty cycle needs to be applied to the
motor 10 and 97 are the min and max duty cycle limits implemented in the code.

b. Velocity: Motor runs in closed loop mode in this control mode. On-Off hysteretic control is
implemented here. The control knob can enter the speed which is tried to be matched by the
hardware. The speed can be seen in the ‘Motor Speed’ box.

c. Pot Control: Motor runs in open loop mode in this control mode. The control knob is disabled in
this case, and the Pot available on the hardware is used for the speed control purpose.

http://www.ti.com
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3. Motor Speed (RPM): The motor speed is indicated in the text box.

4. Flux Threshold: Flux threshold is the integration constant of the motor. Refer to Appendix A for some
of the relevant scope-shots for tuning this value. The flux threshold can be altered during the runtime.

5. Control Knob: The control knob is used to set the duty cycle or required speed during the different
speed control modes as explained below. It also is used to reverse the direction of the motor. The
parameters can be changed by knob or can be entered directly in the text box below the knob.

6. Pole Count: The number of poles of the motor entered here uses for the speed calculations.

7. Start-up Duty Cycle: Changing the value of the start-up duty cycle changes the applied duty cycle
during alignment state. Typical value can vary from 10% to 30% depending upon the motor load and
inertia.

8. Start-up Ramp-up Time: During alignment state of the motor, this ramp-up time defines time duration
for which two of the motor phases remain active for alignment; i.e.,it merely aligns state time duration.

a. Please note that the initial rotor experiences oscillation when it first moves to get aligned with the
stator applied field and try to get locked into it.

b. The oscillation time depends upon the mechanical time constant of motor load and inertia. It is
critical that before applying ‘go state” rotor oscillation dies down sufficiently to avoid commutation
failure.

c. Start-up ramp-up time helps to change the timing of aligning state for different motors to make sure
that rotor oscillation has died down and the rotor has come very near to standstill.

9. DC Bus: The bar graph indicates the DC Bus voltage. The DC bus should be higher than 8 V. If the
voltage drops below the minimum level, then the low voltage indication shows in the status indicator.

3.3 Start Up Process

1. To start and run the BLDC motor, the control algorithm applies the “align and go” method.

a. Align State:

i. The main aim of alignment is to align the rotor to a known position.

ii. This event is done by energizing two of motor phases for the pre-fixed duty cycle to generate a
standstill stator magnetic field for a specific duration.

iii. This known position is necessary to start rotation in the proper direction and to generate
maximum torque at start-up.

b. Go State:

i. Once the alignment is done, the control algorithm applies the next appropriate voltage vector
sequence to produce the stator magnetic field, which is in 90-degree advance to the rotor flux,
to generate maximum torque at starting.

ii. At the same instant, the back emf integration of non-excited phase is initiated, and the next
commutation event occurs once the back-emf integration threshold is reached and the process
continues for the smooth rotation of the motor.

3.4 Rotation Reversal Runtime

The rotation of the motor can be reversed during runtime. The hardware tries to bring the motor to the halt
condition first from where it starts to rotate in another direction. During this period of halting the motor by
the hardware, the GUI is kept disabled for entering other parameters.

3.5 Fault Clearing

In the case of overcurrent/short circuit and over temperature faults at DRV8313, the fault indicator turns
red. Clicking on ‘Reset Fault’ at this time clears the fault and attempt a fresh start and run.

3.6 Menu Options

• File - The File menu contains the option Exit as shown in the figure below.

http://www.ti.com
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Figure 23. File Menu

• Debug - The Debug option can be used for the following operations.

Figure 24. Debug Menu

•

– Demo - By selecting the Demo in the submenu, the GUI runs in simulation mode, and by
unselecting it, the GUI runs in connected mode.

– Log to File - The log to file submenu is used to log the GUI activities to a log file that is specified.

– Debug log - The Debug log option enables to log all the activities of the user. If that is not selected,
only the high-level operations log.

• View - Select View-> Schematics->DRV8313 to view the GUIs schematics

http://www.ti.com
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Figure 25. Schematic

• Help

– Clicking the About in the Help Menu

Figure 26. Help Menu

http://www.ti.com
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– The About Page provides the details like the Name of the GUI, GUI version, Supported OS and
Copyright Information.

Figure 27. About Page

http://www.ti.com
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4 RUNNING THE HARDWARE IN STAND-ALONE MODE

The firmware loaded by default in the MCU on board is a User Experience code. Using this firmware
needs the GUI to run the motor. However, once motor parameters are tuned, the output of the GUI can be
used to operate the hardware in a stand-alone mode (without GUI). The GUI gives these parameters in
the form of the ‘config.c.' the file which is further used to change the code inside the MCU on hardware.

Once the parameters are tuned, clicking on ‘Generate Config File’ generates a config.c file used for the
creating new firmware for the MSP430 device on the hardware. This new code can be flashed via
MSP430 Programming Connector using Spy-Bi-Wire programming method as explained in Appendix B.
User Experience code can be downloaded from http://www.ti.com/tool/drv8313evm. Importing
"DRV8313_Release" project in CCS brings the following view.

Figure 28. CCS Imported Project

Generated config.c file shall be added to the project and then GUI.c must be excluded from the project to
create the firmware for the stand-alone mode.

http://www.ti.com
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Figure 29. Firmware Creation for Stand-Alone Mode
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Appendix A: InstaSPIN-BLDC Implementation

InstaSPIN-BLDC is TI’s one of the critical flagship motor control technology targeted for cost sensitive
sensorless BLDC applications. This sensorless technique uses traditional trapezoidal or 120°
commutations and monitors motor flux by integrating back-EMF of the non-energized phase to determine
the commutation instances. For the specific market, such as fan, pumps, and blowers, which do not
require high accuracy speed control and fast dynamic torque response, InstaSPIN-BLDC implementation
from TI’s MSP430G2x Value line device is the right way to meet low-cost requirements.

For any trapezoidal control of BLDC Motor, for every 60 electrical degrees, only two inverter legs are
active and deliver the power to the motor while third inverter leg is kept in High impedance state by
switching off both high side and low side switches. In the case of Unipolar two quadrant drive, PWM is
applied only to high side switch of one active leg while low side switch of other active leg is kept ON
continuously for one 60 electrical degrees, we need 3 PWM outputs and 3 active signals.

Figure 30. Implementation of 2-Quardent Uni-Polar PWM

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLVU815A
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Appendix A: InstaSPIN-BLDC Implementation

InstaSPIN-BLDC method requires precise sensing of back-EMF of open-phase of motor to determine the
commutation instant. As shown in Figure 30, for first 0 to 60 degree interval, PWM is applied only to
phase-A top switch and in phase-C bottom switch is continuously ON, back-EMF of open-phase B is rising
and can be measured and integrated to determine the commutation instant. As shown in Figure 31, during
on-time of PWM pulse, with Top switch of phase-A connected to VDC, and bottom switch of phase-C
connected to GND, motor neutral terminal potential rises to VDC/2 with respect to GND and back-EMF of
phase B appears at VDC/2 level above GND. By capturing the absolute value of voltage across phase-B
during PWM on pulse and subtracting it with VDC/2, actual value of motor back-EMF can be derived.

Figure 31. Motor Neutral Voltage During PWM On Period

http://www.ti.com
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Appendix A: InstaSPIN-BLDC Implementation

A.1 Tuning the Motor With Proper Flux Threshold

As shown in Figure 30, the commutation instance is derived by integrating back-emf of non-energized
phase (obtain during each PWM on pulse) and comparing the integrated value to pre-defined threshold.
This threshold is in fact equivalent to flux of the motor because it is compared with integrated value of
back-emf. Value of flux threshold depends upon motor phase resistance, inductance and back-emf
constant; therefore this value needs to be tuned for the each different motor for commutation. For tuning
purpose usually oscilloscope is used to see the symmetry of the motor input voltages and/or motor phase
current. Please refer to the following scope-shots for the different flux threshold values.

The scope-shots show the motor input voltage and a current waveform for one phase.

Figure 32. Typical Waveform for the HIGHER Flux Threshold

http://www.ti.com
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Appendix A: InstaSPIN-BLDC Implementation

Figure 33. Typical Waveform for the OPTIMUM Flux Threshold
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MSP430 Programming Using Code Composer Studio (V5)

Appendix B
SLVU815A–November 2012–Revised October 2018

MSP430 Programming Using Code Composer Studio (V5)

After opening Code Composer Studio, under the Project menu, select Import Existing CCS Eclipse
Project.

Figure 34. Import Existing CCS Eclipse Project
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MSP430 Programming Using Code Composer Studio (V5)

Browse to the directory containing the firmware. Check the CCS project found and click on the Finish
button. You may choose to copy the project into workspace before this.

Figure 35. Selecting CCS Eclipse Project

Build the project by clicking on the title and then clicking the Build button as shown in the image below.

Figure 36. Build Project

http://www.ti.com
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MSP430 Programming Using Code Composer Studio (V5)

Download the code onto the board by clicking the Debug button as shown in the following image.

Figure 37. Debug

Once the download is successful, click the Resume button as shown in the image below.

Figure 38. Resume

http://www.ti.com
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MSP430 Programming Using Code Composer Studio (V5)

B.1 Compiling Without GUI.c

For stand-alone mode GUI.c can be excluded from the build and config.c can be added. Refer to the
below screen shots for exclusion of GUI from the project build.

Figure 39. Exclude from Build

Figure 40. Excluding Objects

http://www.ti.com
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MSP430 Programming Using Code Composer Studio (V5)

Figure 41. Build Finished
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STANDARD TERMS FOR EVALUATION MODULES

1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or
documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:

2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License
Agreement.

2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM
to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

3 Regulatory Notices:

3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.



FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に
輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
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【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union

3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

4 EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
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6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT
LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. Limitations on Damages and Liability:

8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated



IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.

TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated
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